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LogTag North America Inc:

This quick start guide covers installation, setup and use for
LogTag® Analyzer 3

LogTag® Analyzer is the free companion software for LogTag® logger
products, used for configuration, download and data analysis. To run
the software, you will need a PC running Windows 7 or later, and a free
USB port. It offers a wide range of charting and reporting options as well
as automation tasks for configuring, downloading and sharing data. This
guide gives a brief overview of its functionality; for detailed instructions
of all features please refer to the comprehensive LogTag® Analyzer User
Guide, installed with the software, or invoke the built-in help function by
pressing the F1 key.

1. DOWNLOADING THE SOFTWARE

You can get your free copy of the LogTag® Analyzer software from
LogTag’s website. Using your browser, navigate to
https://logtagrecorders.com/software/Ita3/download/

and click |pETQEECRI to download the installer file. Please note that
you will require administrator credentials for the PC on which you install
the software.

LogTag®

2. INSTALLATION & SETUP

Double-click the installer file you downloaded - it will be stored in your
Downloads folder and called Itanalyzer_32r12.exe or similar. If you
received a CD or USB Flash Drive containing the software, start it from
there. Select the language, accept the license conditions and follow the
on-screen instructions. When complete, a new icon will be available

on the desktop and in your apps list, which you use to start LogTag®
Analyzer.

If you use non-USB loggers (these have 3 silver contact pins on the
rear) you require an LTI-HID interface. Connect it to a USB port on your
PC. It can be left permanently connected, so you can insert loggers for
configuration or download. If you use a USB logger with a built-in USB
plug, connect it to a free USB port when needed.

3. USER INTERFACE

Once you have started LogTag® Analyzer, the main window will open.
From here, you have access to menu and toolbar commands.

More elements will become visible as soon as you open a file or
download a logger.
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4. BASIC LOGGER CONFIGURATION

Before a logger can be used, it must be set up with the parameters
required for starting and recording temperature values. It is also
desirable to set alarm conditions, so you can be informed when out-
of-specification temperatures were recorded.

To configure a USB logger, first plug it into a USB port on your PC. If
you use an interface cradle, put the logger in the interface, upright,
with the silver contacts towards the rear.

Click Configure from the LogTag menu, or press F3. The configuration
dialogue will be shown:

Configure LogTag(s) UTRID-16 Settings from SN:6045019060

[ Certificate of Calibration J o

User Information

I Description: '0ur description here | LogTag Battery: OK

Configure reguires a password
P  [JDownload requires a password

Password: | **sxsx

Logging Parameters

Push button start ~ | [J Enable pre-start logging

(O Record readings continuously, overwrite oldest when memory full
(® Record readings so that:

Readings recorded will span at least 67 Days

OO

Number of readings to record 16129 | maximum is 16129

RN

> Record a reading every 6 2 | Minutes &
Begin recording after a delay of 12 < | Minutes T
1A
aA [O600 2 Dpisabled .
A3 i After [4] |10 T | |Consecutive ~ | violation readings (1 Hour)
v 05 |« Ater @2 3| Accumulative ~ | violation readings (12 Minutes)
YV |0 300 < |pisabled
Y

Alarm Settings | File Settings  Advanced Settings

’g Configure H% Save Profile ] [Q Cancel ILO Help

The top contains general parameters, while the bottom shows several
tabs with additional settings.

1. Add a description for the logger or the goods it accompanies
2. Optionally, specify a password for next configure or download.
3. Select Date/Time start, or Push button start (with optional pre-start
logging).
4. Specify how long you wish to record for (with optional start delay).
5. Choose the time duration between each reading.
6. Specify the upper and lower temperature alarm trigger conditions.
Add alarms as required, or change any alarms already suggested.
Depending on the logger model, other tabs may be present, which allow
entering wireless settings, humidity alarms, alarms for a second recording
channel, and others. Some models don’t allow certain parameters to
be changed (such as the vaxtag®), as they are mandated by a certifying
bodly.
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5. ADDITIONAL CONFIGURATION PARAMETERS

While the basic configuration is sufficient to prepare a logger for logging,
you can enhance the information you receive at the end of a trip by
setting some additional parameters. These are accessed by clicking the
corresponding tab.

File Settings Tab

This tab is only available for USB loggers and determines the
composition of the PDF file.

. Date Format Time Format Scale Y Axis
Generate data list =
S (® DD/MMAYY O 12-hour (am/pm) | @ Range of readings
O MM/DD/YY (® 24-hour O Range of sensor

[ Show loweer alarm line
Show Y axis grid lines
Show: X axis grid lines
[JShow MKT |83.1440

O Minimum range

PDF temperature unit: |Celsius Upper Limit: ~ 1:0

PDF Time Zone: TC + b
[] Use local PC time zone (UTC +12:00)
PDF Language: B

Files to generate: [V]PDF [JLTD [4]CSV
\ File Settings

7. Select each element you wish to display on the PDF:
e Enable or disable data list, alarm and grid lines
e Determine date and time formats
e Select, which on-board files should be generated
e Choose PDF temperature units, language and time zone

Rl EE

KI/mol Lower Limit: ~ 0.0

e Select the scaling of the chart

Advanced Settings Tab

This tab is available for loggers with a display and controls how the
logger’s buttons are used to control the alarms and other advanced

Advanced alarm options
Alarmremains on even if readings return to non-violation range
B—’» [[JClear and reset all alarms when START/MARK button pressed
[[] Pause alarm/statistics processing for 0 < | readings when button pressed (None)
[] Show alarm screens during review
Advanced logger options
Allow: logging stop with STOP button
n_’ [JAllow reset of logger viith START button

[[] Switch off display after 30 seconds (Power save)
Enable Quick start/stop mode (if supported)

Advanced Settings

options.
8. Complete any advanced alarm related settings

e Define if an alarm remains shown on the display even if
temperatures return to normal, and if an alarm can be cleared

e Set the number of paused readings when a button is pressed
9. Control advanced logger settings

* Allow stopping and resetting the logger

e Enable the power save option
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When you have entered all parameters, click Configure. The logger will
now be configured with the parameters you entered. A progress bar will
let you know when the configuration is finished. Remove the logger from

Interface Type

Logger Serial Number
LogTag USB-HID

UTRID-16 sweossorboro (@
(

progress Bar

the interface, or if it is a USB logger, unplug it and replace the cap. The
logger is now ready to be started and deployed.

6. DOWNLOADING THE RESULTS

At the end of the trip, you can download the data, so it can be viewed,
analyzed and shared with others. With LogTag Analyzer running, just
plug the logger into a USB port or slot it into the interface cradle. The
data is now automatically downloaded and stored on your PC in the
Documents - My LogTag Data folder. If the auto-download function is
disabled, you can also click Download from the LogTag menu or press
F4.
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7. DATA ANALYSIS

Immediately after the data is downloaded, you are presented with a chart
that shows the complete trip including:

e Temperature (and where applicable humidity) values

e Colour coded alarm bands, so you can see if readings went
outside specifications

e Time and temperature axes

e The chart control panel
You can use your mouse to zoom into any area in more detail by
dragging the mouse cursor across the chart canvas (while holding the left
mouse button down). Use the toolbar icons or the mouse wheel to zoom
out.
Readings Range lets you select if you want to see all readings, just the
started readings, or just the pre-start readings.
The chart control panel allows you to turn specific elements of the chart
on or off.
Aside from the initial Chart tab, you can also see other tabs at the
bottom of the file window. These tabs present the loggers’ data in
different ways. Click one of the tabs to show the following information:
Report tab: This tab shows a summary report of the trip, combining
the most important statistical data of the trip with a small chart.
Data tab: In this tab you will find a list of all temperature readings
currently visible presented in the chart, which can be all readings, or
only those that are zoomed.
Summary tab: In this tab data is presented in summary form, grouped
by events such as inspection marks. You can also see a section for
only the zoomed readings. Statistics include calculated values such
as minimum, maximum and average values, standard deviation, mean
kinetic temperature and degree minutes.
Day Summary tab: This tab contains a day summary from loggers
with statistics memory, such as the vaxtag® or TRED30-16R loggers,
where each of the last 30 days is listed with minimum and maximum
values.
It is also possible to combine data from several loggers into a single multi
chart file for comparison. You can use this for mapping studies, or to
compare the data from recurring trips.
LogTag Analyzer allows you to annotate charts. Enable this feature using
the button in the chart control panel, then add text, callouts and other
data to your chart canvas, such as statistical data.

8. EXPORTING AND SHARING DATA

Data can be saved in different formats and shared with other users. You
can export the data to CSV files (which can be opened by Excel), text
files, HTML files and PDF files. This can be done automatically when a
logger is downloaded, or using Save as from the File menu. Each of
these file types can be customized.

You can send files manually via email to a list of recipients, or upload
them to an FTP server for others to download. Use the toolbar icons
(Send Mail and Upload) or the corresponding commands from the
File menu. This can also be done automatically each time a logger is
downloaded.

LogTag Analyzer also allows files to be uploaded directly to your LogTag
Online account. LogTag Online is LogTag’s cloud-based storage and
reporting platform, which allows access to data from wherever a
browser and internet connection are available. You will need to provide
your account details and enable this feature in the settings. If enabled,
you can additionally open files directly from LogTag Online using the
Open command from the File menu.

9. CUSTOMIZING THE SOFTWARE

A large number of parameters that define the appearance and behavior
of the software can be customized to your personal preferences.
They are accessed by clicking the Options toolbar icon, or by clicking
Options from the Edit menu, and then selecting one of the tabs. These
preferences are stored separately for each user, and can be exported
and imported on other PC’s. Following is a brief summary of these
options.
General Settings: Select which language and temperature units the
software is using, how often the software checks for available updates
and what default time interval to display in the chart.
Summary Statistics: Select which statistics values should be shown
in the statistic tab.
Chart Statistics: Select which statistics values should be shown in

the chart annotation window.

Charts: Influence how the chart appears, which markers to display,
what colors to show, how the mouse works and what the chart will be
called.

Automation: Here, you determine how much of your download, re-
configuration and sharing process will be automated. In this section
you also enter the details for your FTP and SMTP server details, so
your logger data can be sent and uploaded.

File and Folder: This section determines where the data that is
downloaded from your loggers is stored, and what the files will be
called.

Exports and Reports: Here, you determine which export files are
automatically generated when a logger is downloaded, and how each
format is customized.

Date and Time: Here you can set how dates and times are displayed
in all tabs, reports and exports. This is also where you define which
time zone is used by default to display the data.

LogTag Online: This allows you to control some aspects of the
automation relating to LogTag Online.

10. GETTING HELP

If at any stage you feel the user guide and help don’t answer your
questions, and you need further help, please contact your sales partner
or visit the LogTag support website at
https://logtagrecorders.zendesk.com/hc/en-us for assistance.
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